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Abstract 

 

This Thesis addresses the issue of rockfall instability and its mitigation, focusing specifically on 

the case study of a slope in Varallo (VC, North-West Italy). This region has been prone to rockfall 

phenomena over the years, with significant consequences for the road situated at its base. 

Through the application of Rocfall 3D using the Rock Science Simulation Tool, the study 

evaluates the rockfall risk and proposes strategies to enhance the safety of the infrastructure. 

The analysis begins by estimating the rock block volume for the simulations, referred to as the 

design block, using various methodologies available in the literature. These include simpler 

methods based on blocks already fallen at the slope’s base, as well as more complex statistical 

analysis. Subsequently, the parameters involved in the trajectory simulations are defined through 

a back analysis of a rockfall event that occurred in November 2023. 

Further simulations are carried out considering multiple scenarios, such as varying block 

volumes. The study concludes with the proposal of different mitigation interventions for the 

rockfall hazard based on the outcomes of the trajectory analyses, providing recommendations for 

improving the safety of the road and surrounding areas. 
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1) Introduction 
 
Rockfalls are a common hazard in mountainous and hilly terrains, typically resulting from a variety 
of natural processes such as erosion, weathering, seismic activity, and rainfall. These events, 
where rock masses break away from slopes and descend rapidly, pose significant risks to both 
infrastructure and human life.[4] 
The unpredictability of rockfall events, combined with the challenging and often steep topography 
of mountainous regions, makes them a complex phenomenon to study and mitigate.[2][4] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1. Rock fall occurred near Valtopina, Umbria 



1. 2) Rockfall Triggering Factors 
 

Rockfalls are primarily triggered by a combination of structural and environmental factors. 
Structurally, rockfalls occur when a loose mass of rock on a slope becomes unstable due to a 
variety of mechanisms, such as jointing or the presence of pre-existing fractures in the rock mass. 
The physical and chemical weathering of rocks, along with the freeze–thaw cycles, can weaken 
the cohesion of these rock masses, making them more susceptible to failure.[2][3] 

Environmental factors like heavy rainfall, rapid temperature fluctuations, and seismic shaking are 
also significant triggers. These events can increase pore water pressure, causing further 
weakening of the rock structure. Additionally, human activity such as excavation, construction, 
and the use of heavy machinery can contribute to destabilizing slopes. Furthermore, any vibration, 
whether caused by seismic activity or human-made sources, can initiate a rockfall, often with 
significant consequences.[4]  

 

 

 

 

Figure 2. Rockfall in South Tyrol, Italy 21 may 2023 



1. 3) Factors Affecting Rockfall Behavior 
 

Once a rockfall has been initiated, the subsequent motion of the rock is influenced by various 
factors including slope geometry, material properties, and surface conditions. 
The slope geometry, including factors such as angle, length, and surface roughness, plays a 
crucial role in the velocity and direction of the falling rock. For example, steep slopes typically 
accelerate rocks more quickly, while surface irregularities can change the path of the rock, 
causing it to bounce or roll.[4] 

The material properties of the rock and the surface it interacts with further affect the behavior of 
the rock during its descent. Harder rocks, for example, tend to travel further than softer rocks, and 
their shape and size contribute to how much kinetic energy they carry. Larger rocks generally 
possess more energy and travel further before coming to a stop.[2][4] 

Human interventions, such as the construction of retaining walls or roads, can also impact 
rockfall behavior by creating artificial pathways that alter the natural motion of falling rocks.[8] 
Similarly, the presence of vegetation may slow down the movement of smaller blocks but may not 
prevent larger rocks from continuing their path down the slope.[3] 
The conceptual model illustrated in [Figure 3] summarizes the typical kinematic domains of a 
rockfall event, describing the transition from the release area to the final deposition zone. It 
highlights the key geometrical parameters—such as the reach angle (α) and shadow angle (β)—
that control the maximum runout distance of falling blocks. 

 

Figure 3. Mechanics and modelling approaches of rockfall [9] 
source: Arabian Journal of Geosciences 

 

https://link.springer.com/journal/12517
https://link.springer.com/journal/12517


 

1. 4) Rockfall Failure Mechanism 
 

The mechanism by which a rock mass fails and triggers a rockfall is determined by its structural 
properties. Rock masses are typically fractured into discrete blocks by discontinuities, such as 
joints or faults. The orientation of these discontinuities with respect to the slope is critical in 
determining whether a rock mass will fail by sliding, toppling, or other failure modes. [3] 

1. Planar failure occurs when a block of rock slides along a plane of weakness that is aligned 
with the slope, while wedge failure happens when two intersecting joint sets form a wedge 
that can detach and slide down the slope. 

2. Toppling failure is associated with the rotation of blocks that are constrained at the bottom 
but loose at the top, often occurring on steep slopes with joints or fractures dipping away from 
the slope face. 

The different mechanisms through which a rock slope may fail are illustrated in [Figure 4] showing 
the most common failure modes—including planar, wedge, toppling and circular failures—each 
governed by the orientation and interaction of structural discontinuities. 

. 

 

Figure 4. Types of slope failure; a planar, b wedge, c & d toppling, e circular[4] 

https://www.researchgate.net/figure/Types-of-slope-failure-a-planar-b-wedge-c-d-toppling-e-circular-Hoek-and-Bray-1981_fig9_381803060


1. 5) Rockfall Hazard Assessment 
 

Rockfall hazard assessment is a critical aspect of evaluating the risk posed by rockfalls to 
infrastructure and human life. It involves analyzing three key components: susceptibility, 
frequency, and propagation.[1][5] 

• Susceptibility refers to the likelihood that a rockfall will occur in a specific area based on 
local terrain conditions, including the slope angle, material properties, and existing 
fractures.[1] 

• Frequency pertains to the temporal occurrence of rockfalls, often determined through 
statistical analysis of past events and their recurrence intervals.[5] 

• Propagation describes the trajectory and runout distance of falling rocks, which is 
influenced by the slope's geometry and surface characteristics.[5] 

The conceptual scheme shown in [Figure 5] illustrates the typical spatial subdivision of a rockfall 
path, including the release zone, the transition zone and the final deposition area. This 
representation highlights how block motion evolves downslope and how the shadow angle 
governs the maximum runout distance. 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 5. Laser Scanning Systems and Techniques in 

Rockfall[4] 



2) The Rockfall Susceptibility Index to Failure (SIF) 
 

To estimate how likely a rock block is to become unstable and detach from a slope, the Rockfall 
Susceptibility Index to Failure (SIF) was introduced as a semi-quantitative method based on a 
combination of geological and environmental factors. These factors describe the main causes 
that make a slope prone to failure and were selected through an extensive review of the scientific 
literature.[1][2] 

For practical use, the factors were grouped into three main categories: 

• The first group (Table A) includes general predisposing and triggering factors, which can 
be found in any type of terrain, regardless of the local environment. 

• The other two groups (Tables B1 and B2) describe conditions that are specific either to 
mountainous areas (B1) or to coastal–marine settings (B2). 
Since a site can belong to only one of these two environments, the B1 and B2 tables are 
considered mutually exclusive. 

 

Each factor f is divided into classes according to its degree of influence on rockfall initiation, and a 
numerical score P is assigned. The scores usually range from 0 (very low susceptibility) to 3 (very 
high susceptibility), representing how strongly each factor contributes to potential instability. 

In some special cases—such as when effective stabilization or protection works are present—
negative scores (up to −1) can be applied to reduce the overall susceptibility, since these 
structures lower the probability of detachment. 

Once all relevant factors are evaluated, the SIF index is calculated by combining their weighted 
contributions. The formula slightly differs depending on whether the site is located in a mountain 
or coastal–marine environment.[1][2] 

 

 

 

 

 



For mountain environments, the SIF is defined as: 

𝑆𝐼𝐹 =
∑(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵1) − ∑min⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵1)

∑max⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵1) − ∑min⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵1)
 

 

 
For coastal–marine environments, it is expressed as: 

𝑆𝐼𝐹 =
∑(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵2) − ∑min⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵2)

∑max⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵2) − ∑min⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵2)
 

 

 

where: 

• 𝑃𝑓,𝐴is the weight assigned to each factor in Table A[ Figure 7] 

• 𝑃𝑓,𝐵𝑖(where i = 1 or 2) is the weight assigned to the factors in Table B1 or Table B2 [Figure 

7] 

• ∑min⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵𝑖)represents the sum of the minimum possible weights for all factors; 

• ∑max⁡(𝑃𝑓,𝐴 + 𝑃𝑓,𝐵𝑖)represents the sum of the maximum possible weights. 

 

If one or more parameters cannot be properly assessed—such as when visibility of the slope is 
limited—the corresponding minimum and maximum values are excluded from the computation 
so that they do not distort the final index. 

In essence, the SIF equation normalizes the total influence of all instability factors, transforming it 
into a dimensionless number between 0 and 1. Values close to 1 indicate a high probability of 
rock detachment, while values near 0 correspond to stable conditions. 

This formulation allows for a consistent comparison between different areas of a slope and 
provides a solid quantitative basis for identifying the most hazardous zones. 

 



 

Figure 6. A Novel Approach to Assess the Influence of Rockfall Source Areas: 

The Case Study of Bardonecchia (Italy) 

https://www.mdpi.com/2076-3263/13/12/386


 Figure 7. Parameters controlling rock blocks failure probability: classification and relative scores.  
The SIF index can be obtained by combining the weights assigned to the parameters of Tables A+B1 in the case of mountain 

environment, or A+B2 in the case of coastal-marine environment. 

TABLE A - General 

WEIGHT, P 

PARAMETER 
-1 -0.5 0 0.5 1 2 3 

Slope angle   <15° 15°-30° 30°-45° 45°-70° >70° 

 

Rock mass structural 

conditions* 

  
 

Massive rock with no or 

a few discontinuities 

(Jn=0.5÷1) 

 

One set of 

discontinuities 

(Jn =2÷3) 

 

Two sets of 

discontinuities 

(Jn =4÷6) 

Three sets of 

discontinuities, rock 

mass subdivided 

into small cubes 

(Jn =9÷12) 

More than three sets 

of discontinuities, 

highly fractured 

rock mass 

(Jn =15÷20) 

Discontinuity aperture * 
  Closed or slightly 

opened 

 
1 mm - 1 cm 1 cm - 10 cm >10 cm 

Stability conditions *   Stable  Partially stable Unstable  

Fracturing degree of the 

rock mass ** 

  
Low 

 
Medium High Very high 

 

Expected rockfall events 

  
Few events (1/10 years) 

- no rockfall scars 

 
Occasional events 

(3/year) 

Many events-visible 

rockfall scars 

(6/year) 

Numerous and 

frequent events 

(9/year) 

Precipitation   Low  Moderate Intense  

Aggravating conditions  

Unstable blocks and/or 

overhanging sectors 

  
None 

  
Present 

Geological singularities 

(presence of faults, low 

resistance interlayers, 

heterogeneity, etc.) 

   

 

None 

  

 

Present 

 

Seepage/water 
  No/a few water seeps 

on slope 

 Numerous water seeps 

on slope 

 

Lateral or foot torrential 

erosion 

  
None 

 
Present 

 

Seismicity   Low  Moderate High 

 

Stabilization works 

Fully 

efficient/ 

effective 

Partially 

efficient/ 

effective 

 

None 

   

TABLE B1 - Mountain environment 

Lithology   Good quality rock   Soft rock 

Freeze–thaw cycles   None  Present  

TABLE B2 - Marine environment 

 

Slope orientation 

  Favorable (roughly 

shore-normal storm 

wave fronts) 

 Adverse (shoreline 

subparallel to main 

storm wave fronts) 

 

 

 

Elevation of the source 

area a.s.l. 

  
High enough not to be 

affected by the 

erosive/unstable effects 

caused by waves, sea 

spray and tides 

 Not high enough to 

exclude 

erosive/unstable 

effects caused, even 

indirectly, by waves, 

sea spray and tides 

Low enough to be 

affected by the 

erosive/unstable 

effects caused by 

waves, sea spray 

and tides 

Lithology and sensitivity 

to the erosive action of 

the sea 

  
Good quality rocks 

(metamorphic, volcanic, 

etc.) 

 
Medium quality rocks 

(limestones,sandstones 

conglomerates, etc.) 

Rocks of low quality 

or sensitive to the 

marine environment 

 

Tidal effect 

  Not applicable, altitude 

of the source area 

sufficiently high 

Low 

oscillations 

Significant 

oscillations 

 

 

Wave energy 

  Not applicable, altitude 

of the source area 

sufficiently high 

 

Moderate 

 

High 

 

Very high 

Cliff foot directly 

exposed to waves/tides 

  
Not applicable - 

Protective beaches or 

engineering structures 

 
No protective beaches 

or engineering 

structures 

 

Coastal retreat rate *   Very limited/limited  Significant  

Karst features   None  Limited Significant 

 

https://www.researchgate.net/figure/Parameters-controlling-rock-blocks-detachment-probability-classification-and-relative_fig1_374925995


3) Site Characterization 

3.1) Geographical and Geological Setting 
 

The study area is located in the municipality of Varallo, within the Valsesia Valley (Vercelli 
province, Piedmont Region, Northern Italy). This sector of the Sesia Valley is characterized by 
steep rocky slopes that frequently experience rockfall events, mainly affecting the provincial road 
that runs along the valley floor and several nearby infrastructures.[1] 

Coordinates (WGS-84): 
Latitude = 45° 48′ 50″ N (≈ 45.8139°)  
Longitude = 8° 15′ 30″ E (≈ 8.2583°)  

 

 

 

 

 

Varallo lies within the central segment of the Ivrea–Verbano Zone, a geological unit belonging to 
the Southern Alps. The rock slope investigated in this study mainly consists of kinzigites, which 

Figure 8. Exact location of Roccapietra Varalo, Vercelli 

https://www.google.com/maps/place/13019+Varallo+Province+of+Vercelli/@45.7968021,8.2759288,1984m/data=!3m1!1e3!4m6!3m5!1s0x4786059297927fab:0x1a99cf50f0189113!8m2!3d45.8144736!4d8.254354!16s%2Fg%2F119t72m3n?entry=ttu&g_ep=EgoyMDI1MTAyNy4wIKXMDSoASAFQAw%3D%3D


are coarse-grained paragneisses of pre-Ordovician age. These rocks have undergone high-grade 
Variscan metamorphism, leading to the formation of minerals such as biotite, sillimanite, 
cordierite, garnet, quartz, muscovite, plagioclase, and K-feldspar.[1] 

 

 

 

 

Partial melting (anatexis) processes generated pockets and veins of granitic composition, giving 
the rock a migmatitic texture. Locally, the secondary lithology includes the Roccapietra granite, a 
biotite–hornblende granodiorite belonging to the local granitic pluton. Dioritic rocks from the 
Appinitic suite of Lower Permian age are also present in minor amounts. 

The structural setting of the slope shows a dense network of joints, foliation planes, and fractures, 
often favorably oriented with respect to the slope face, thus promoting potential rock 
detachments. The overall geological and structural conditions make the site highly susceptible to 
instability phenomena, particularly along the southwestern and central-western sectors of the 
slope.[1] 

 

 

 

 

Figure 9. Samples of kinzigites 



3.2) Rockfall History and Previous Events 
 

The Varallo slope has been affected by several rockfall events over the past decades. According 
to the Regional Landslide Inventory (SIFRAP) of the Piedmont Region, two major events (IDs 
2001390 and 20033600) have been recorded in the area. 

In November 2023, a significant rockfall event occurred, involving a kinzigite block of 
approximately 3 m³, which detached from the upper part of the slope and impacted the road at its 
base, causing considerable damage. 

 

Following this event, detailed field surveys and photogrammetric inspections were conducted to 
assess the stability of the remaining rock masses. A large number of unstable blocks were 
identified, particularly in the southern sector of the slope, where subsequent rock-scaling 
interventions were carried out by professional climbers to remove potentially unstable fragments. 

In addition, two rockfall barriers, installed in the 1990s and later in 2012, were found to have 
successfully stopped tens of falling blocks, providing valuable data for the estimation of block 
sizes and trajectories. These historical and observational data were essential for the calibration of 
both the Rocfall3D simulation and the susceptibility indexes.[1] 

 

 

 

 

Figure 10.a) detachment niche located on the Barbavara castle rock slope;  
b) kinzigite rock block of about 3 m3 that detached in 

c) road damaged by the rock collapse[1] 



3.3) Field Survey and Data Collection 
 

A series of in-situ surveys and geospatial analyses were carried out to prepare the input data 
required for the 3D simulation and susceptibility mapping. 
The surveys aimed to: 

1. Evaluate the rock mass conditions and identify major discontinuities. 

2. Measure and record the size, volume, and position of previously detached rock blocks. 

3. Assess the efficiency and damage state of the existing mitigation structures. 

The Digital Terrain Model (DTM) of the area, provided by regional authorities, was processed in 
QGIS to obtain key morphological parameters such as slope angle, aspect, and curvature. The 
DTM resolution was high enough to allow the accurate delineation of the main geomorphological 
features influencing rockfall behavior.[1] 
The Digital Terrain Model used for the geomorphological analysis is shown in [Figure 11], 
highlighting the extent of the study area as imported and visualized within the QGIS environment. 

 

Figure 11. DTM view in QGIS 



4. Methodology and Software Tools 
 

4.1 Overview of the Adopted Methodology 
The numerical analysis performed in this study combines both GIS-based modeling and 3D 
physical simulation in order to evaluate the rockfall hazard affecting the Varallo slope. 
Two main software environments were used: 

• QGIS, an open-source Geographic Information System employed for spatial analysis 
and susceptibility mapping; 

• Rocfall 3D, a 3D numerical simulator developed by Rocscience, used to reproduce 
the kinematic behavior of falling rock blocks and to estimate the corresponding impact 
energies and runout distances.[6] 

• Rockyfor3D, a physically based rockfall model that includes soil–block interaction, 
vegetation influence, and probabilistic runout estimation, complementing the purely 
kinematic simulations of Rocfall 3D [5]. 

The integration between these two tools allows a multi-scale investigation of the 
phenomenon: while QGIS provides a territorial-level susceptibility analysis based on 
topographic and geological parameters, Rocfall 3D allows a detailed understanding of the 
physical motion and energy distribution of individual blocks.[1][6] 

 

 

 

 

 

Figure 12. QGIS Software 

Figure 13. Rocfall 3D Software 



4. 2) QGIS Workflow and procedure 

 

4.2.1) Workflow Overview 
 

The GIS-based part of this study was carried out in QGIS, where the complete workflow included: 

1. Preprocessing the Digital Terrain Model (DTM) and vector data. 

2. Deriving topographic parameters (slope, aspect, curvature). 

3. Defining and importing the source points. 

4. Running the QPROTO plugin to simulate potential runout zones using the Cone Method. 

5. Generating and exporting the final susceptibility and impact maps. 

 

4.2.2) Data Preparation in QGIS 

 

The regional Digital Terrain Model (DTM), provided as DTM_merged.tif, was imported into QGIS 
using: 
Layer → Add Layer → Add Raster Layer which we can see in [Figure 14] 
All layers were projected into a common coordinate system (EPSG:4326 – WGS84) to ensure 
spatial consistency. 



 

Figure 14. Importing DTM file to QGIS 

 

 

4.2.3) Source Points Definition 
 

The identification and import of source points in QGIS represented a fundamental step for 
defining the potential detachment areas along the Varallo slope. These points indicate where rock 
blocks are most likely to detach and where the QPROTO analysis begins. 

The source points layer was provided as a shapefile named PointsFINAL.shp, accompanied by 
its associated files (.shx, .dbf, .prj, and .cpg). 
To load this dataset into QGIS: 

1. Open the menu Layer → Add Layer → Add Vector Layer 

2. In the “Source” panel, browse and select the PointsFINAL.shp file. 

3. Ensure that the coordinate reference system (CRS) matches the project CRS — typically 
EPSG:4326 (WGS 84) or the regional CRS used for the DTM. 

4. Click Add to display the points in the QGIS workspace. 

Once imported, the layer appeared as a collection of discrete points located over the slope 
surface [Figure 15. Each point corresponds to a potential rockfall release location. 



By opening the Attribute Table of the layer which is shown in Figure 16, it was possible to verify 
and edit the associated attributes (e.g., ID, SIF value, sector, or volume category). If necessary, 
new fields could be created to store values such as: 

 

• SIF index (Susceptibility Index to Failure) for each point, 

• Rock block volume, 

• Elevation 

• Mass 

• Slope Angle 
 
 

 
 

 

Figure 15. The case Study DTM with Source Points 



 

Figure 16. The Attribute Table of Source Points 

 
 

4.2.4) QPROTO – Rockfall Runout Simulation and SIF-Weighted Susceptibility 
 

QPROTO implements the Cone Method (Jaboyedoff & Labiouse, 2011; Castelli et al., 2021), 
which provides an empirical yet effective way to estimate the potential propagation of falling 
blocks starting from predefined source points. 

For each source point, QPROTO constructs a visibility cone that geometrically represents all DTM 
cells potentially reachable by a falling block, based on parameters such as: 

• Energy line angle (φp): controls the steepness of the cone and represents the equivalent 
friction between block and slope. 

• Lateral spreading angle (α): controls the horizontal spread of trajectories around the 
central direction. 

• Dip direction (ω): defines the orientation of the slope at the detachment location. 

All DTM cells falling inside this cone are considered part of the potential runout area. 
By repeating this operation for all source points, QPROTO creates a map of cumulative visibility 
— indicating the number of sources that can reach each cell. [Figure 17] 
When weighted by the SIF (Susceptibility Index to Failure) values, this map becomes a SIF-



weighted susceptibility map, which highlights the sectors most likely to generate hazardous 
rockfall impacts. 

 
  

 

 

 

 

 

 

 

 

 

 

 

 

The values were calibrated according to the geometry of the Varallo slope and in agreement with 
previous studies by Napoli et al. (2024–2025). 

The main output files exported from QPROTO were: 

• The SIF-weighted susceptibility raster  

• The final points layer  

 

 

 

 

Figure 17. The QPROTO plugin and data inputting 



4.3) Rocfall 3D Workflow 

4.3.1) Overview and Comparison with Rocfall 2D 

 

Rocfall 3D, developed by Rocscience Inc., is an advanced numerical tool designed to simulate 
the three-dimensional trajectories of falling rock blocks along a digital surface. 
Unlike its predecessor Rocfall 2D, which performs two-dimensional, cross-sectional analyses, 
Rocfall 3D allows a full spatial representation of rockfall dynamics on complex terrains. 

In Rocfall 2D, the simulation is limited to a single vertical or inclined profile, meaning that all 
block trajectories follow a single plane defined by the slope line. 
While this approach is useful for preliminary analyses, it neglects the natural lateral dispersion, 
surface curvature, and three-dimensional variability of real slopes. 

In contrast, Rocfall 3D integrates: 

• a triangulated 3D surface mesh (from a DTM), 

• 3D block trajectories that can deviate laterally, 

• and the ability to compute spatial outputs such as impact energy maps, runout 
envelopes, and endpoint distributions. 

This makes Rocfall 3D a far more realistic and comprehensive tool for assessing rockfall 
hazard.[6] 

 

4.3.2) Preparing Input Data 

 

Before launching any simulation, Rocfall 3D requires that all spatial input files be properly 
formatted. 
In this study, two types of files were prepared: 

1. the terrain surface, derived from the Digital Terrain Model (DTM), and 

2. the source points, representing potential detachment locations. 

 

 

Rocfall 3D requires the terrain model to be imported as one of these Formats: 



• RS Geometry Object (*.rsgeomobj) (Rocscience Geometry object file format) 

• OBJ Files (*.obj) 

• STL Files (*.stl; *.stlbin) 

• Autodesk Files (*.dxf; *.dwg) 

• STEP Files (*.step) 

• IGES Files (*.iges; *.igs) 

• TIN Files (*.tin) 

• ASC Files (*.asc) 

• LAS Files (*.las) 

• LUCAS Files (*.mdl) 

• SHP Files (*.shp) 

• PLY Files (*.ply) 

• Deswik DUF Files (*.duf) 

• Slide3 Result Object (*.slide3dresobj) 

• DTM Files (*.dtm) 

• OFF Files (*.off) 

 

Before performing the 3D numerical simulations, the terrain model and source points needed to 
be properly formatted for compatibility with Rocfall 3D. 

Specifically, the Digital Terrain Model (DTM) originally available in GeoTIFF format (.tif) was 
converted to an ASCII grid (.asc), while the source points provided as a shapefile (.shp) were 
exported as a comma-separated table (.csv). 

These conversions were carried out within the QGIS environment to ensure full geospatial 
consistency between datasets.[6] 

 

The conversion was executed directly in QGIS, using the Translate (Convert format) function 
available under the raster conversion tools. 
Through this process, the DTM was translated from GeoTIFF to AAIGrid (.asc) format while 



preserving its original spatial resolution, cell size, and extent.  
A NoData value of -9999 was assigned to maintain consistency during import into Rocfall 3D. 
[Figure 18] 

The resulting DTM_merged.asc file represented the final gridded surface of the Varallo slope and 
was subsequently used by Rocfall 3D to reconstruct the three-dimensional terrain geometry. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 18. Converting Geotiff format to ASC 



4.3.3) Reduction of the DTM Extent for the Varallo Domain 

 

The original DTM_merged.asc file covered a considerably large portion of the Sesia Valley, 
extending far beyond the actual rockfall area of interest. 
When imported into Rocfall 3D, this large dataset resulted in excessive rendering time and 
computational load, making the visualization and simulation process extremely slow and 
inefficient. 

To overcome this limitation, the DTM extent was reduced to include only the area surrounding 
the Varallo slope, where the 2023 rockfall event occurred. 
This refinement allowed the model to focus exclusively on the relevant geomorphological features 
while significantly improving processing performance and rendering speed within Rocfall 3D. 

The reduction of the DTM was carried out within QGIS prior to the conversion to ASCII format. 
Specifically, the Clip Raster by Extent tool (from Raster → Extraction → Clip Raster by Extent, 
[Figure 19]) was used to delimit the boundaries of the analysis domain. 
The extent coordinates were manually set to encompass only the Varallo study area. 
Alternatively, the Select by Polygon option was also tested to visually crop the DTM based on a 
user-defined boundary around the slope. 

 

 

 

 

 

 

 

 

 

 

 
Figure 19. DTM extension phase by QGIS 



4.3.4) Conversion of Source Points 

 

In addition to optimizing the terrain model, the source point dataset also required specific 
formatting adjustments to ensure correct import and coordinate recognition in Rocfall 3D. 
The original vector layer (PointsFINAL.shp) contained accurate planimetric coordinates (X, Y) but 
did not include the elevation (Z) values in a format directly readable by Rocfall 3D. 
When the shapefile was tested for import, the software was unable to correctly interpret the 
altitude data, resulting in misplaced or flattened release points on the surface. 

To solve this issue, all source points were exported from QGIS as a comma-separated file in 
CSV format. [Figure 20 
During this conversion, the Add geometry attributes function was first used to attach the elevation 
(Z) extracted from the DTM to each point. 
The updated layer was then saved as a CSV file containing three columns — X, Y, and Z — 
representing the full three-dimensional position of each potential release location. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 20. Converting Source Point to CSV format 



4.3.5) Importing the Terrain and Source Data into Rocfall 3D 

 

After the DTM preprocessing in QGIS, the reduced and optimized terrain file (DTM_Varallo.asc) 
was imported into Rocfall 3D to generate the three-dimensional slope surface. 

There are two possible methods for importing the terrain into the software. 
The first method consists of importing the terrain using its exact georeferenced coordinates, 
which preserves the original spatial position and alignment of the model with real-world data.[6] 

 

 

 

 

 

 

 

 

Figure 21. Import Terrain in Rocfall 3D 



 
But in this case study import was carried out using the: 

 Geometry → Surface Triangulation Tools → Add Surface From Points [Figure 22 
 
Once loaded, the program automatically created a triangulated surface mesh based on the 
elevation values contained in the ASCII grid. 

During this stage, several mesh-quality checks were performed to ensure that the geometry was 
consistent with the real morphology of the Varallo slope.[6] 

 

 

 

 

 

 

 

 

 

Figure 22. Importing DTM inro Rocfall 3D 



After importing has been completed we can see all the points with their data. 

Once the 3D surface was correctly generated, the release points were imported using the 
previously prepared file PointsFINAL_XYZ.csv.  
This file contained the full three-dimensional coordinates (X, Y, Z) of each source location, 
allowing each block to be initialized exactly on the slope surface at its true elevation. [Figure 23] 

The import was completed through the same way as DTM, selecting the corresponding 
coordinate columns and matching the project coordinate system. [Figure 24 
Each imported point appeared as a small marker on the 3D mesh, confirming the correct 
georeferencing of all sources.[6] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 24. DTM data on Rocfall 3D Figure 23. Source Points data on Rocfall 3D 



  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

After importing, the reconstructed mesh was explicitly declared as the active slope surface in 
the model. This assignment ensures that all contact, impact, and rolling calculations are 
performed with respect to the same ground geometry used to derive the seeders’ elevations, 
avoiding inconsistencies where blocks might otherwise “see” a default or inactive surface. 

In practice, the imported terrain mesh was set as the primary ground/slope surface for the 
analysis; no auxiliary meshes, or temporary scaffolds were left active. 

For setting the surface is main slope we selected set slope from Geometry.[6] 

Figure 25. Total view of the site after importing data 



4.3.6) Definition of Rock Block Properties 

 

After successfully importing the terrain and source datasets, the physical and mechanical 
parameters of the falling rock blocks were defined. 
The properties were selected to represent kinzigite boulders, consistent with the lithology of the 
Varallo slope. 

The mechanical and physical parameters adopted for the simulated rock blocks are summarized 
in Table 1, representing the typical properties of kinzigite boulders observed at the Varallo slope. 

 

 

 

 

 

 

 

Column1 Column2 Column3 Column4

Parameter Symbol / Unit Value Description

Block density ρ (kN/m³) 27
Derived from field data and 

literature for kinzigite

Block volume V (m³) 5.4
Design volume corresponding to a 

25-year return period

Coefficient of normal 
restitution

Rn 0.40 – 0.55
Defines rebound energy loss upon 

impact

Coefficient of 
tangential restitution

Rt 0.80 – 0.95 Governs sliding and rolling behavior

Surface friction angle φ (°) 30 – 40
Estimated from slope roughness 

and field inspection

Damping ratio ξ 0.1 – 0.12
Energy dissipation factor during 

impacts

Table 1.The mechanical and physical parameters 



The statistical distributions assigned to the mechanical parameters of the simulated blocks are 
shown in Figure 26, where normal and tangential restitution coefficients, as well as the surface 
friction angle, were defined using normal distributions to account for natural variability in block–
terrain interactions. 

 

 

According to the geological characteristics of the Varallo slope, the simulated blocks were 
modeled as kinzigite boulders, consistent with the lithology observed in the field. 
The design block volume was defined as 5.4 m³, which represents the typical block size 
estimated from the field survey and from the results of the QPROTO analysis. 

Based on published physical data for kinzigitic paragneisses, the material density was set to 
2,600 kg/m³. 
This value was introduced into the Block Properties window of Rocfall 3D [Figure 27], and the 
corresponding block mass was automatically computed using the relation:[5] 

𝑚 = 𝜌 × 𝑉 

 

Substituting the adopted parameters: 

𝑚 = 2,600 kg/m³ × 5.4 m³ = 14,040 kg. 
 

Thus, each simulated block had a total mass of approximately 14.0 tons, which represents a 
realistic estimate for the detached rock fragments observed at the Varallo site. 
These values ensured that the model reproduced the correct inertial and kinetic behavior of the 
falling blocks, providing physically consistent results in terms of trajectory, impact energy, and 
runout distance.[1]  

Figure 26.The statistical distributions assigned to the mechanical parameters in Rocfall 3D 



 

 

 

 

 

 

 

 

 

 

 

 

4.3.7) Importing Seeders on Rocfall 3D 

 

In Rocfall 3D, a seeder is a release entity that defines where blocks start and how many 
realizations are generated at that location (including any statistical perturbations on 
direction/speed). Each seeder sits on the terrain surface and “spawns” a user-specified number 
of blocks that inherit the global block properties above.[6] 

What a seeder controls. 

• Spatial location: 3D coordinates (𝑋, 𝑌, 𝑍)on the mesh (must coincide with the terrain to 
avoid floating or buried starts). 

• Multiplicity: number of blocks emitted per seeder (we used 50 per point to build stable 
envelopes). 

• Direction rule: by default, along local steepest descent; optional angular jitter can be 
added for variability. 

• Timing: simultaneous release (single burst) for envelope mapping; staged release is also 
possible but not required here. 

 

Figure 27. Seeders Properties on Rocfall 3D based on calculation 



 

4.3.8) Importing Seeders on Rocfall 3D 

 
In Rocfall 3D, seeders can be introduced into the model through three different methods, 
depending on how the release zones are represented: 

1. Point Seeder: individual coordinates are specified for each detachment point. 

2. Line Seeder: a continuous line is drawn along the crest or face of the slope, and blocks 
are released at regular intervals along that line. 

3. Area Seeder: a polygonal surface is defined on the slope, and seeders are automatically 
distributed inside that area according to the user-selected density. 

All three options allow the definition of initial block positions and directions of release, but 
they differ in how the sources are spatially generated.[6] 

During the Varallo analysis, both the line and area seeder methods were initially tested in 
order to reproduce the geometry of the most unstable sectors observed in the QPROTO 
susceptibility map. 
However, the results obtained from these automated methods were not satisfactory: 

• The line seeder tended to place blocks too uniformly along the ridge, without matching the 
actual detachment locations observed in the field. 

• The area seeder generated release points outside the critical zones and produced 
unrealistic cluster patterns on the surface. 

Because of these limitations, the final configuration was created using manually defined 
point seeders. 
For this purpose, the exact X, Y, and Z coordinates of each potential release point—
previously exported from QGIS as PointsFINAL_XYZ.csv—were entered directly into Rocfall 
3D using the Add Seeder function.[ Figure 28] 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 29. Adding Point seeders of study area 

Figure 28. Adding Points Coordinates manually 



5. Results and Discussion 
 

5.1) General Overview 
 

The comparison between the results obtained with Rocfall 3D, Rockyfor3D (developed under 
the guidance of Dr. G. Cavagnino)[10][11], and the GIS-based analyses in QGIS provides a 
coherent understanding of rockfall dynamics along the Varallo slope. 
Despite the different modeling approaches, all three methods produced comparable trajectory 
patterns, energy distributions, and impact zones, confirming the reliability of the adopted 
geometric and mechanical parameters. 

The following sections present a focused discussion of three key indicators that best describe the 
destructive potential of rockfall events: translational velocity, kinetic energy, and SIF. These 
parameters allow a direct comparison between the GIS-based susceptibility assessment and 
physically simulated block behavior. 

 

 

5.2) SIF Calculation and Comparison 

 

All the SIF values used in this study refer exclusively to the southern sector of the slope, which 
is the most unstable portion of the site and the area where the November 2023 rockfall occurred. 
Both the QGIS-based analysis and the Rocfall 3D simulations were therefore restricted to this 
zone to ensure consistency between the susceptibility assessment and the physical propagation 
models. 

The QPROTO workflow provides SIF values directly through the SIF-weighted susceptibility map, 
allowing the identification of the sectors with the highest detachment propensity. However, 
Rocfall 3D does not compute SIF, as the software is purely a kinematic simulator and does not 
include a susceptibility module. For this reason, and in order to perform a homogeneous 
comparison, the SIF values associated with the Rocfall 3D source points were manually 
computed using the normalization formula introduced in Section 2 of this thesis. The numerical 
outputs extracted from the Rocfall 3D simulations are shown in [Figure 30], summarizing the 
maximum kinetic energy, translational velocity, runout distances and the computed SIF values for 
each source point in the southern sector. 



 

By applying the SIF formulation to the set of factors evaluated for the southern source points 
(Tables A and B1), the resulting average SIF value is 0.67. This value is in excellent agreement 
with the reference data reported in previous studies on the Varallo slope, where the SIF for the 
southern sector was quantified as approximately 0.70 [1] 

 

The spatial distribution of SIF-weighted susceptibility derived from the QGIS analysis is presented 
in[ Figure 31], highlighting the sectors where the combination of high detachment propensity and 
favorable runout conditions produces the greatest rockfall hazard. 

 

 

Figure 31. SIF-weighted runout frequency (or susceptibility) map in QGIS [1] 

Figure 30. Points Data Exported from Rocfall 3D 



Also The two-dimensional and three-dimensional trajectories generated by Rocfall 3D are shown 
in [Figure 32] and [Figure 33] , highlighting the propagation paths of the simulated blocks across the 
southern sector of the Varallo slope. The visualization on the 3D terrain model clearly illustrates 
the concentration of runout directions toward the valley floor and the areas most exposed to 
potential impacts. 

 

 

 

 

 

 

 

 

 

 

 

Figure 32.Two-Dimensional block path in Rocfall 3D 

Figure 33. Three-Dimensional block path in Rocfall 3D 



5.3) Comparison of Kinetic Energy Results 
 

The comparison of translational kinetic‐energy results across Rockfall 2D, Rocfall 3D, and 
Rockyfor3D highlights how both the block volume and model dimensionality influence energy 
propagation. 

The Rockfall 2D back-analysis, carried out using a block volume of 3.0–3.25 m³ (corresponding 
to the November 2023 event), produced a maximum kinetic energy of ≈ 2.18 MJ, which represent 
the critical part of the slope.  
These values derive from the design-energy envelopes provided in the 2D simulation outputs, 
where the vertical fall path and single-plane dynamics result in greater energy dissipation and 
therefore lower KE values overall.[8] 

In contrast, the Rocfall 3D simulation was performed using a larger and more representative 
design block volume of 5.4 m³, consistent with the statistical volume estimation defined for the 
Varallo slope. With this volume, Rocfall 3D yielded substantially higher kinetic energies, with 
maximum values reaching about 3.6 MJ along the steep upper sector of the slope. In Figure 36 all 
these data were highlighted. 
 The 3D modelling framework captures full terrain morphology, multi-directional motion, and 
more realistic impact behaviors, allowing the blocks to retain a larger fraction of their mechanical 
energy. 

Similarly, Rockyfor3D was run using the same 5.4 m³ block volume (Tavola 4). The resulting 
95th-percentile kinetic-energy values (≈ 3.0–3.5 MJ) closely match those of Rocfall 3D and 
identify the same high-energy corridor oriented toward the southwestern sector of the slope.[11] 

Overall, the two 3D models (Rocfall 3D and Rockyfor3D) display excellent agreement in both the 
magnitude and spatial distribution of kinetic-energy peaks, confirming that the parameters used in 
Rocfall 3D are properly calibrated. 
The lower energies obtained in Rockfall 2D (~2.18 MJ) are fully consistent with: 

1. the smaller block volume used (≈3.25 m³), and 

2. the inherent geometric simplifications of 2D trajectory modelling. 

This comparison demonstrates that the 5.4 m³ simulations in both Rocfall 3D and Rockyfor3D 
provide a reliable representation of future detachment scenarios, while Rockfall 2D remains 
consistent with the documented 2023 back-analysis. 
The 95th-percentile translational kinetic-energy distribution obtained from the Rocfall 3D 
simulation is shown in [Figure 37], illustrating the spatial concentration of high-energy impacts 
along the southwestern sector of the Varallo slope. 



 

 

 

Figure 34.“Energia cinetica kJ –  
analisi scendimenti potenziali volume 5,4 m³”[10] 

Figure 35. “Energia cinetica kJ –  
verifica a ritroso evento franoso 16 novembre 2023”[11] 

Figure 36. Translational Kinetic Energy Volume in Rocfall 3D 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 37.The 95th-percentile translational kinetic-energy distribution 



5.4) Translational Velocity Results 
 

The analysis of translational velocity further clarifies the dynamic behaviour of the blocks and 
complements the comparison previously carried out on kinetic energy.  
In the Rocfall 2D back-analysis, performed on five sections of the slope using three design block 
volumes (4.20 m³, 3.25 m³ and 2.10 m³), the 95th-percentile translational velocity does not vary 
significantly with block volume. The maximum value is obtained with a peak velocity of 
approximately 25.37 m/s, These results are consistent with the 2D geometric constraint, where 
motion is confined to a single profile and lateral dispersion is not represented.[8] 

The Rocfall 3D simulations, carried out with a larger and more representative design block 
volume of 5.4 m³, indicate higher velocities. The maximum translational velocity reaches 30–31 
m/s (≈108 km/h) along the steepest part of the southern sector, decreasing below 5 m/s near the 
foot of the slope . The distribution of velocity closely mirrors the kinetic-energy pattern, with the 
highest speeds concentrated in the central flow corridor that directs blocks towards the 
provincial road. 

For Rockyfor3D, the available Tables mainly report the spatial distribution of kinetic energy for 
the same 5.4 m³ design block, rather than explicit velocity maps. However, the location of the 
highest-energy cells coincides with the same southwestern corridor identified by Rocfall 3D, 
indicating a comparable dynamic behavior: the zones where Rockyfor3D predicts the highest 
impact energies correspond to the areas where Rocfall 3D records its maximum translational 
velocities.[11][10] 

Overall, the comparison shows that: 

• Rocfall 2D (3.25 m³) predicts peak velocities up to ≈26 m/s, 

• Rocfall 3D (5.4 m³) increases the peak to ≈30m/s as shown in [Figure 38] 

• Rockyfor3D (5.4 m³) identifies the same high-velocity/high-energy corridor, even if 
velocity is inferred indirectly from energy maps. 

The higher velocities in the 3D models are consistent with both the larger block volume adopted 
(5.4 m³ vs. 3.25 m³ in 2D) and the more realistic three-dimensional representation of the slope, 
which allows blocks to follow the steepest descent paths and maintain higher speeds over longer 
distances. 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 38. Translational Velocity in Rocfall 3D 



6. Conclusion 
 

The comparative analysis clearly shows that Rocfall 3D and Rockyfor3D provide coherent and 
mutually reinforcing descriptions of rockfall behaviour at the Varallo slope. 
Both modelling approaches consistently identify the southwestern sector as the most 
hazardous portion of the site, where the highest translational velocities and kinetic-energy values 
are concentrated. 

Using the same design block volume (5.4 m³), the two models yield highly compatible results. 
Rocfall 3D predicts a maximum kinetic energy of about 3.5 MJ and peak velocities of 30–31 
m/s, values that match the high-energy zones highlighted in the Rockyfor3D simulations. 
This close agreement indicates that the physical parameters adopted for the Rocfall 3D analysis 
are well calibrated and consistent with independent modelling. 

Overall, these findings confirm that Rocfall 3D successfully reproduces the kinematic 
behaviour observed during the 2023 rockfall event, providing a reliable basis for future hazard 
assessments and the design of protective structures in the Varallo area. 
Despite the conceptual differences between the two software tools, the strong convergence in 
both energy and velocity results increases the confidence in the adopted methodology and 
confirms the robustness of the three-dimensional modelling approach. 
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